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About the Brainware Intelligent Capture Update Guide
This guide provides information about updating Intelligent Capture products from a previous version to BIC
Foundation EP1.

Read this guide before you update Runtime Server machines, Verifier and Designer workstations, andWeb
Verifier servers.

We recommend completing the update procedure in a development environment before updating a production
environment.

Note: This document does not provide information about upgrades from versions 1.3.x and 2.x. If you need
to upgrade from versions 1.3.x or 2.x, contact your Support representative.

Affected Workstations and Servers
The update affects the following workstations or servers.

l Runtime Server (RTS)machines
l Verifier workstations
l Development workstations
l WebVerifier servers

About Backward Compatibility with Other Hyland Applications
This version of BIC does not support file system storage. All BIC Foundation EP1 implementations require
database storage.

If you use the Brainware Capture scanningmodule with PIC 5.5 SP2 or earlier and you want to upgrade to BIC
Foundation EP1, youmay keep using the older version of Capture on a separatemachine and use the RTS
image import workflow step. Capture is not available in this version of BIC and you cannot install or use it on
the samemachine.

Service Names
The installer deletes the Runtime Service and the SystemMonitoring service and recreates them with new
names when upgrading from version 5.8 or earlier.

Possible previous service names New service name

l IDC-distiller Runtime Service Manager
l Brainware Distiller Runtime Service
Management Console

l Perceptive Intelligent Capture Runtime
Service Manager

Brainware Intelligent Capture Runtime Service
Manager
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Possible previous service names New service name

l IDC-distiller System Monitoring
l Brainware Distiller System Monitoring
l Perceptive Intelligent Capture System
Monitoring

Brainware Intelligent Capture System Monitoring

Back Up all Data and Settings
To retain your unique customizations and back up your settings, consult your database administrator to create
a full database backup of the ORACLE orMS SQLServer database. Then, complete the following tasks.

Note: Archive the backup data in read-only format until BIC is running in a production environment. Neither
Hyland Software, Inc. nor any of its authorized resellers are responsible for lost data caused by any update
procedure described in this document.

l Back UpRuntime Server Settings
l Note the Runtime ServiceManager Settings
l Back Up Project-Related Data
l Back Up the Application Files
l Back Up the License File
l Back Up the Configuration Files
l Back Up Permissions and Security Settings

Back UpRuntime Server Settings
To back up the RTS settings, complete the following steps.

1. Stop all Intelligent Capture services.
2. Launch Intelligent Capture Runtime Service Management Console.
3. In theDstAdminwindow, in the left pane, right-click the topmachine node and click Stop All.
4. Repeat the previous step for eachmachine.
5. To export the settings, complete the following substeps.

1. In the left pane, right-click an instance and then click Export Settings.
2. In theSave As dialog box, navigate to your backup directory.
3. In the File name box, type a name that uniquely identifies the instance, and then click

Save.

Note: Use a combination of the RTS machine name and the instance name to
simplify re-importing.

4. Repeat the previous substeps for all instances on all machines.
6. Close Intelligent Capture Runtime Service Management Console.
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Note the Runtime ServiceManager Settings
To note the existing Runtime ServiceManager settings for future reference, complete the following steps.

1. LaunchWindows Services and stop the following services.
l Intelligent Capture Runtime ServiceManager
l Intelligent Capture SystemMonitoring

2. Complete the following substeps.
1. Right-click Intelligent Capture Runtime Service Manager and then click Properties.
2. In the Intelligent Capture Runtime Service Manager Properties dialog box, on the

Log On tab, note the specified settings.
3. Repeat the previous steps for the Intelligent Capture System Monitoring service.

3. Launch the Task Manager.
4. If they are running, stop theDstHost.exe orDstMgr.exe tasks.

Back Up Project-Related Data
When you save a project in Intelligent Capture 5.7 or later, you cannot open it in an earlier version. To back up
all project-related data, complete the following steps.

1. Stop all Intelligent Capture services.
2. InWindows Explorer, navigate to the Intelligent Capture project directory.
3. Copy all of the following files to your backup directory.

l SDP project files
l Learn set directories and files
l ASSA pool files
l INI files
l SET files
l DVS files
l Any other project-related data, such as custom DLL files, scheduled tasks, or special
configurations

Note: Formore information about your projects, see the project-related documentation.

4. If the batch folder resides on the file system, copy the batch folder to your backup directory.

Back Up the Application Files
To back up the application files, complete the following steps.

1. Stop all Intelligent Capture services.
2. InWindows Explorer, navigate to the [Installation path] directory.
3. Optional. To reduce the size of the backup, delete any log files that you no longer need.
4. Copy all files to your backup directory.
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Back Up the License File
To back up the license file, complete the following steps.

1. Stop all Intelligent Capture services.
2. Navigate to the [Installation path]\Components\Cairo directory.
3. Copy the license file to your backup directory.

Back Up the Configuration Files
Use the CONFIG backup files only as reference to review custom settings used in previous versions. Do not
copy any existing CONFIG files to the installation setup directory. Do not use any backed up CONFIG files
with the new version.

To back up the configuration files, complete the following steps.

1. Stop all Intelligent Capture services.
2. From the [Installation path]\bin directory, copy the following files to your backup directory.

l DstDsr.exe.config
l DstHost.exe.config
l DstSlm.exe.config
l DstWkBrw.exe.config
l DstVer.exe.config
l DstPmt.exe.config
l DstCoreSvc.exe.config (if available)
l If your installation includesWeb Verifier, from the [Installation path]\Brainware
Intelligent Capture Web Server directory, copy theWeb.config file to your backup
directory.

Back Up Permissions and Security Settings
To back up permissions and security settings, complete the following steps.

1. Stop all Intelligent Capture services.
2. Note the permissions and security settings of any shared directories that Intelligent Capture uses,

such as project data directories.
3. Ensure that the share names remain the same for any directories youmove.
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Upgrade to Brainware Intelligent Capture Foundation EP1
To upgrade to BIC Foundation EP1, review or complete the following tasks as necessary.

l Prepare for the Update
l Upgrade Intelligent Capture

l from versions 5.2 or earlier
l from versions 5.3 or later

l Update the database schema
l SQLServer
l Oracle

l Modify the Database Connection Strings
l Convert Existing Project Files to the Current Version
l Configure the ApplicationModules

Prepare for the Update
To prepare for the update, complete the following steps.

1. In the Learn Set Manager, complete all pending accumulated documents andmigrate them into
the project.

2. Verify that no pending batch exports exist.
3. Verify that all users have logged out of the following programs.

l Designer
l Verifier
l Learn Set Manager
l WebVerifier

4. Stop all RTS instances.
5. Stop all Intelligent Capture services.
6. Stop Internet Information Services (IIS).
7. Stop all scheduled tasks and additional services related to BIC.
8. Optional. To specify the Help file locations, modify the SetupType.ini file.

Note: See “Help files” in theBrainware Intelligent Capture Installation and SetupGuide for
detailed steps and information.
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About Documentation
The installer removes any existing Intelligent Capture documentation files when upgrading from version 5.6 or
earlier.

Upgrade from Version 5.2 or Earlier
To upgrade from version 5.2 or earlier, complete the following tasks.

1. Uninstall an Existing Version
2. Upgrade from version 5.2 or earlier to Foundation EP1

Uninstall an Existing Version
To upgrade from a version prior to 5.3, youmust uninstall your existing version from all servers and
workstations.
To uninstall your version, complete the following steps.

1. On each server and workstation, complete the following substeps.
1. InWindows Programs and Features, uninstall the existing version.
2. Reboot themachine.

2. On eachRTSmachine, delete the following directories.
l [drive:]\Windows\Temp\Bwe
l [drive:]\Windows\Temp\DIST
l [drive:]\Windows\Temp\CdrDbCache

Upgrade from Version 5.2 or Earlier
This topic provides a broad overview of the tasks you complete to upgrade to the latest BIC version.
See theBrainware Intelligent Capture Installation and SetupGuide for detailed steps and information.

Complete the following steps.

1. Install BIC Foundation EP1with an attended or unattended installation.
2. If prompted, reboot themachine.
3. Replace the demo license file with the back-up license file.
4. Verify the installation of the components.
5. Configure any shared and security customizations from previous installations against the

application directories.
6. If your implementation uses the file system, migrate the batches from the file system to the

database.

Upgrade from Version 5.3 or Later
To upgrade from version 5.3 or later, complete the following tasks.

1. Upgrade from version 5.3 or later
2. Upgrade to Kadmos 5 and FineReader 11
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3. Set Kadmos 5 as the Default Recognition Engine

Upgrade from Version 5.3 or Later
This topic provides a broad overview of the tasks you complete to upgrade to the latest BIC version.
See theBrainware Intelligent Capture Installation and SetupGuide for detailed steps and information.

Complete the following steps.

1. Run setup.exe and complete the following substeps.
1. In theBrainware Intelligent Capture Setup page, click Next.
2. In the License Agreement page, read and accept the End-User License Agreement

(EULA), and then click Next.
3. In theSetup page, select Repair and then click Next.
4. Click Finish.

2. Update the database schema.
3. LaunchDesigner and convert existing project files.
4. Restart all RTS instances.
5. Restart all BIC services.
6. Restart Internet Information Services (IIS).
7. Restart all scheduled tasks and additional services related to BIC.
8. If your implementation uses the file system, migrate the batches from the file system to the

database.

Upgrade to Kadmos 5 and FineReader 11
If your current implementation does not include Kadmos 5 or FineReader 11, and you want to upgrade them,
youmust rerun the installation process. BIC can work with existing projects that use FineReader 8.1.
However, we recommend that you upgrade to FineReader 11.
To upgrade to Kadmos 5, FineReader 11, or both, complete the following steps.

1. Verify that the license file contains a Kadmos 5 and a FineReader 11 entry.
2. Run setup.exe.
3. In theBrainware Intelligent Capture Setup page, click Next.
4. In the License Agreement page, read and accept the End-User License Agreement (EULA), and

then click Next.
5. In theSetup page, selectModify and then click Next.
6. In the Feature Selection page, select Kadmos 5, FineReader 11, or both, and then click Next.
7. In the Icons on Desktop page, click Finish.

About the Kadmos 5 Server Add-On
To process documents for multiple users with multiple processors, a Kadmos 5 Server add-on is available.
For more information, see theBrainware Intelligent Capture Kadmos 5 Server Installation Guide.
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Set Kadmos 5 as the Default Recognition Engine
If you open a project that uses an obsolete OCR engine, such as Kadmos 4 or FineReader 8, BIC updates the
assigned engine.
To define Kadmos 5 as the default recognition engine, complete the following steps.

1. InDesigner, switch toDefinition Mode.
2. In the left pane, right-click <new project> and then click Show Properties.
3. In the right pane, click OCR settings and then, in theOCR Properties dialog box, on the

Recognition tab, complete the following substeps.
1. UnderRecognition Type, select OCR.
2. UnderAvailable Engines, select Kadmos 5.
3. Select Use as default engine and then click OK.

About Projects Using the Recognita Barcode Engine
The Recognita Barcode Engine is no longer part of BIC.

If you open a project that previously used the Recognita Barcode Engine, BIC updates the project to the
QualitySoft Barcode Engine and transfers the existing bar code types if the QualitySoft Barcode Engine
supports these types.

About Projects Using the Recognita OCREngine
The Recognita OCR Engine is no longer part of BIC.

If you open a project that previously used the Recognita OCR Engine, BIC updates the project to FineReader.

Update the SQL Server Database Schema
To update the database schema, complete the following steps.

Note: After the update, you cannot revert the database schema to an older version.

1. Launch theSQL Server Management Studio.
2. Log in using an account with administrator rights.
3. From the [drive:]\[setup directory]\FirstPart\Database\UpdateScripts\SQL Server directory,

execute theBRW_Upgrade_Database.sql script against the BIC database.
4. Review theMessages pane for errors.

Note: If there are errors, you can rerun the script as often as required.

Update the Oracle Database Schema
To update the Oracle database schema, complete the following steps.

Note: After the update, you cannot revert the database schema to an older version.
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1. Ensure that the BIC user has the appropriate permissions. For more information, see "Create the
database user" in theBrainware Intelligent Capture Installation Guide.

2. To execute the update script usingSQL Developer, complete the following substeps.
1. Configure a connection for the BIC user.
2. From the [drive:]\[setup directory]\FirstPart\Database\UpdateScripts\Oracle

directory, open theBRW_Upgrade_Database.sql script.
3. Ensure that the connection is set to the BIC user and then execute the script.

3. To execute the update script usingSQL Plus, complete the following substeps.
1. Start SQL Plus and connect to the database as the BIC user.
2. From the [drive:]\[setup directory]\FirstPart\Database\UpdateScripts\Oracle

directory, execute theBRW_Upgrade_Database.sql script.
4. Review theMessages pane for errors.

Note: If there are errors, you can run the script as often as required.

RevokeOracle User Rights
After creating or updating the Oracle database, you can revoke some of the permissions from the BIC user
because they are no longer needed. Complete the following step.

l Revoke the permissions according to the following example.

REVOKE
CREATE TYPE,
CREATE INDEXTYPE,
CREATE PROCEDURE,
CREATE SEQUENCE,
CREATE SYNONYM,
CREATE PUBLIC SYNONYM,
CREATE TRIGGER

FROM BIC;

Modify the Database Connection Strings
Tomodify the database connection strings for all BIC components, except Web Verifier, complete the
following steps.

Note: Tomodify the database connection strings forWeb Verifier, see the “ReplaceWeb.config and
Brainware.System.Project.exe.config ” topic.

1. From the [Installation path]\Brainware Intelligent Capture\bin directory, openDstDsr.exe.config in
a text editor.

2. Search for the <connectionStrings> element.
3. For a SQL Server database, modify the following values.

l Set Data Source to the data source.
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l Set Initial Catalog to the SQL Server database catalog.
l Set User ID to the SQL Server user ID.
l Set Password to the SQL Server password.

4. For anORACLE database, modify the following values.
l Set Data Source to the data source.
l Set User ID to the service account user ID.
l Set Password to the service account password.

5. Save and close the file.
6. Repeat the previous steps for the following configuration files.

l DstHost.exe.config
l DstSlm.exe.config
l DstVer.exe.config
l DstWkBrw.exe.config
l DstCoreSvc.exe.config
l DstPmt.exe.config
l Brainware.System.Project.config

Add the ASP.NET 4.x Role to IIS
To add the ASP.NET 4.x role to IIS, complete the following steps.

1. InServer Manager, open theAdd Roles and Features Wizard.
2. In theAdd Roles and Features Wizard dialog box, click Next.
3. Select Role-based or feature-based installation and then click Next.
4. Select Select a server from the server pool and then click Next.
5. OpenWeb Server (IIS) > Web Server > Application Development.
6. Select ASP.NET 4.x and then click Next.
7. Click Next and then click Install.

Change the Application Pool .NETCLRVersion to v4.0.30319
To change the application pool .NET CLR version to v4.0.30319, complete the following steps.

1. In Internet Information Server (IIS) Manager, openSites, and then select theWeb Verifier
application.

2. In the right pane, click Basic Settings.
3. In theEdit Application dialog box, from theApplication Pool field, note the pool name and then

click OK.
4. In the left pane, select Application Pools.
5. In themiddle pane, right-click theWeb Verifier application pool name and then click Basic

Settings.
6. In theEdit Application Pool dialog box, from the .NET CLR version list, select .NET CLR

Version v4.0.30319 and then click OK.
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ReplaceWeb.config andBrainware.System.Project.exe.config
If your installation includes Web Verifier, complete the following steps.

1. From your BIC setup directory, make a copy of theWeb.config.Template file, name it
Web.config, and open it in a text editor.

2. Search for the <connectionStrings> element.
3. For a SQL Server database, modify the following values.

l Set Data Source to the data source.
l Set Initial Catalog to the SQL Server database catalog.
l Set User ID to the service account user ID.
l Set Password to the service account password.

4. For anORACLE database, modify the following values.
l Set Data Source to the data source.
l Set User ID to the service account user ID.
l Set Password to the service account password.

5. Search for the pathToProjectExe attribute and verify that the value corresponds to the location
of DstDsr.exe.

6. Compare all customized settings, such as formEvents, batchColumnsVisibility, and
appSettings with your back-upWeb.config file andmodify the values if required.

7. Save and close the file.
8. Copy theWeb.config file to the following directories.

l [Installation path]\Brainware Intelligent Capture\bin
l [Installation path]\Brainware Intelligent CaptureWeb Server

9. In the [Installation path]\Brainware Intelligent Capture\bin directory, complete the following
substeps.

1. Rename the Brainware.System.Project.exe.config file to a new name to save it as a
backup, or delete it.

2. Rename theWeb.config file toBrainware.System.Project.exe.config.

Database Connection String Example for SQL Server
<connectionStrings>
<add name="Entities"
connectionString="metadata=res://*/Entity.Entities.csdl|res://*/Entity.Entiti
es.ssdl|res://*/Entity.Entities.msl; provider=System.Data.SqlClient;provider
connection string=&quot;Data Source=<DataSource>;Initial
Catalog=<SQLServerDatabaseCatalog>;Integrated Security=false;User
ID=<UserId>;Password=<UserPassword>;MultipleActiveResultSets=True&quot;"
providerName="System.Data.EntityClient" />
</connectionStrings>



Brainware Intelligent Capture Update Guide

16

Database Connection String Example for ORACLE
<connectionStrings>
<add name="Entities"
connectionString="metadata=res://*/Entity.ORAEntities.csdl|res://*/Entity.ORA
Entities.ssdl|res://*/Entity.ORAEntities.msl; provider=EFOracleProvider;
Provider Connection String='Data Source=<OracleServerName\InstanceName>;User
ID=<UserID>;Password=<UserPassword>'" providerName="System.Data.EntityClient"
/>
</connectionStrings>

Modify the .NETConfiguration for ORACLE
If you use BIC with anORACLE database, complete the following steps.

1. From <drive>:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\CONFIG, open
machine.config in a text editor.

2. Search for the <system.data> element.
3. Under the <DbProviderFactories> element, verify or add the following element.

Provider for Oracle testing"
type="EFOracleProvider.EFOracleProviderFactory, EFOracleProvider,
Version=1.0.0.0, Culture=neutral, PublicKeyToken=def642f226e0e59b"/>

Note: To copy this example as a single line, open this document in Acrobat Reader and copy
and paste the string from there.

4. Save and close the file.

Convert Existing Project Files to the Current Version
Youmust convert project files created in an earlier version before you can use them.
To convert existing project files, complete the following steps.

1. InDesigner, click File > Load Project.
2. In theBrainware Intelligent Capture – Load Project dialog box, select a project and click Open.
3. In theBrainware Intelligent Capture – Project Logon dialog box, log in withAdministrator

credentials and then click OK.

Note: The fully automated conversion process may take a few minutes, depending on the
project size.

4. If prompted, confirm the error message about themissing FineReader 8.1 engine.
5. Verify if you need tomodify the scripts.
6. To verify the settings, click Options > Settings.
7. In theSettings dialog box, complete the following substeps.

1. On the Input Mode tab, verify that the required job name is selected or that theBatch
Root Directory points to the required batch directory.
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2. On the Train Mode tab, verify that the Learn Set Manager base directory points to the
required directory and then click OK.

8. Switch to Train Mode.
9. On theOptionsmenu, clear Incremental Learning.

10. To rebuild the learn set under the current version, on the Toolbar, click Learn documents
11. Switch toDefinition Mode.
12. the left pane, on theClasses tab, right-click the project and then click Show Properties.
13. In the right pane, on theProject tab, click OCR settings.
14. In theOCR Properties dialog box, complete the following substeps.

1. On theRecognition tab, underAvailable Engines, verify that FineReader 11 is
selected.

2. Verify the settings on the different tabs.
15. BIC now provides the possibility to perform a combinedOCR for Korean and English in one

selection. If your project uses Korean and English, in theOCR Properties dialog box, complete the
following substeps.

1. On the Languages tab, underUsed, removeEnglish andKorean.

2. Under Installed, select Korean+English, click and then click OK.
16. Upgraded projects may have correlation enabled for table fields. To review and disable this setting

if not applicable for this project, complete the following substep.
l InDefinition Mode, open the properties of all table fields and clear the correlation option
on theAdvanced tab of theAnalysis pane.

17. For local projects, complete the following substeps.
1. Click Options > Users, Groups and Roles.
2. On theUsers tab, select Allow Database Authentication and then click OK.

18. Click File > Save Project.
19. Repeat the previous steps for each project.

About Custom DLLs
Custom DLLs may have to be updated to remain valid with the current BIC version.

Configure the ApplicationModules
After the update you configure the applicationmodules. Complete the following tasks.

l Configure RTS Settings on a Server
l Verify Verifier settings
l Verify Web Verifier settings on the server
l Verify Web Verifier on a client
l Re-Register the COMComponents
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Configure RTS Settings on a Server
To configure the RTS settings on a server, complete the following steps.

1. InWindows Services, complete the following substeps
1. Right-click Brainware Intelligent Capture Runtime Service Manager and then click

Properties
2. In theBrainware Intelligent Capture Runtime Service Manager Properties dialog

box, on the Log On tab, change the settings according to those used in the previous
version.

3. Repeat the previous steps for theBrainware Intelligent Capture System Monitoring
service.

4. Start theBrainware Intelligent Capture Runtime Service Manager service.
2. InBrainware Intelligent Capture Runtime Service Management Console, create the RTS

group and the RTS machines using the same names than in the previous installation.

Note: Refer to your backed up SET files to review the previously used names.

3. Verify that the licensingmachine uses the correct license file.
4. Complete the following substeps.

1. In the left pane, right-click one of the instances and then click Import Settings.
2. In theOpen dialog box, select the corresponding SET files and then click Open.
3. Repeat the previous steps for each instance.

5. Verify that the batch list displays for each instance.
6. Verify that no errors display in theStatistics view.
7. To verify the configuration, process a single document from import to export.

Verify Verifier Settings
To verify the Verifier settings on a server or client, complete the following steps.

1. Copy the backed upVerifier settings file to the required location.
2. To launchVerifier, double-click the settings file.
3. In theBrainware Intelligent Capture – Project Logon dialog box, log in withAdministrator

credentials and then click OK.
4. Verify that the batch list displays.
5. Verify a batch to completion to ensure that no errors occur.

Verify Web Verifier Settings on the Server
To verify theWeb Verifier settings on the server, complete the following steps.

1. On the BIC Web server, in IIS Manager, start theWeb Verifier application.
2. Run iisreset as an administrator in aCommand Promptwindow.
3. Open a web browser and delete all local cache information.
4. Log in toWeb Verifier.
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5. Click Help > About Brainware Intelligent Capture Web Verifier and verify the license file.
6. Verify a batch to completion to ensure that no errors occur.

Verify Web Verifier on a Client
To verify Web Verifier on a client, complete the following steps.

1. Open a web browser and delete all local cache information.
2. Log in toWeb Verifier.
3. Verify a batch to completion to ensure that no errors occur.

Re-Register the COM Components
To re-register the COM components, complete the following steps.

1. In the [Installation path]\Brainware Intelligent CaptureWeb Server\Bin directory, runRegister Web
Server.bat as administrator.

2. In the [Installation path]\Brainware Intelligent CaptureWeb Server\Bin directory, openRegister
Web Server.log in a text editor and check the file for errors.

ReviewScripts
To check if your scripts require modifications, review the following topics.

1. About the Properties Filename and DocFileName
2. About the Original File Name of a Page
3. About Cutting and Appending Documents

About the Properties Filename and DocFileName
The Workdoc.Filename property now contains the workdoc’s database ID and name instead of the image
file name from which the workdoc was created.

To retrieve the image file name from which BIC created the workdoc, use the Workdoc.DocFileName
property.

Ensure tomodify your projects custom script accordingly.

About the Original File Name of a Page
The stapling process returns a single multipage-document referenced by the associated workdoc.

Using the pWorkdoc.DocFileName(x) with an index greater than 0 results in an index-out-of-range error.

To retrieve the original file name of a page, use the pWorkdoc.Pages
(x).OriginalDocumentFileName property.

About Cutting and Appending Documents
The process for cutting and appending documents has changed.

Always use the pWorkdoc.DocFileCount property after appending and cutting operations to determine
the number of documents.
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Migrate Batches from the File System to the Database
If the RTS instance points to file system batches, youmust migrate those batches to the database.
Tomigrate a file system batch to the database, you need to perform themigration steps for each state within
the batch starting with the lowest batch state. BIC creates a single batch for each state. If a file system batch
contains documents at two different states, BIC splits this batch into two different batches in the database.
Tomigrate the batches to the database, complete the following steps.

1. Back up the file system batches.
2. LaunchBrainware Intelligent Capture Runtime Service Management Console.
3. In theDstAdminwindow, in the left pane, right-click the RTS instance that points to a file system

batch and then click Properties.
4. In theBrainware Intelligent Capture Runtime Service Properties dialog box, on theWorkflow

tab, complete the following substeps.
1. Enable theDatabase Export process step.
2. Disable all other process steps and then click OK.

5. In theDstAdminwindow, in the left pane, right-click the RTS instance and then click Properties.
6. In theBrainware Intelligent Capture Runtime Service Properties dialog box, on theGeneral

tab, underDirectories, create a new job or select an existing one.
7. Complete the following substeps.

1. In theBrainware Intelligent Capture Runtime Service Properties dialog box, on the
Workflow tab, select the lowest batch state as Input State for Database Export.

Note: Explore your batch list to determine the lowest state.

2. Define separate states different from the existing default output states as Output State
for Database Export, and then click OK.

Note: Verify that the failed state is lower than the succeeded state.

3. Right-click the instance and then click Start.
4. Repeat the previous steps for all remaining states in your batch list.

About Batches Exported from the Database
When performing a database export from the Runtime Server, BIC creates a new ID for the exported batches,
such as 00001770_00000016. The left part of this ID represents the database ID while the right part
represents the previous file system batch ID.

This affects only the batches exported from the file system and is required to keep the string ID unique. If you
import the batches directly into the database, the string ID consists of the reference to the database ID.
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Find Exported Batches
If a case in the file system has two different states, BIC creates two different database batches.
To find the batches created from the original single batch, complete the following step.

l In the DstAdmin window, in the right pane, in theWhere box, type batch.name like ‘%_
[xx]’ and then click Request.

Example If you want to display all documents for batch 16, type batch.name like ‘%_16’.

Note: The RTS instance that points to a file system batch still shows the original number of
documents even if a part of the documents was already exported. The exported documents are
still part of the batch. However, after export they have a higher state according to the output
state you defined for database export.

About Transliteration Differences
Transliteration is an advanced feature not commonly used in projects.

PIC 5.5 SP1 and SP2 incorrectly transliterate text in extended languages, such as Russian or Thai, when the
project has the "Usemulti-byte encoding" setting enabled. Projects using transliteration built in PIC 5.5 SP1
or SP2may require a correction to utilize the correct transliterated texts in later versions.

Example

l In PIC 5.5 SP1 and SP2, the Russian word for “Invoice” incorrectly transliterates to "Sqet".
l In PIC 5.3, 5.4, and 5.5 SP3, the word correctly transliterates to "SChET".
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